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ABSTRACT
Today's technology uses high level behavioral languages such as VDHL to do
hardware electronic design. The project is selected in VHDL to learn the current technology
and the methods to do hardware design. The name of the project is FIFO in computer science
FIFO are use in queue structure. The fist data to be added to the queue will be the first data to
be read. So the process proceeds sequentially in the same order.
Today's technology we don't go and buy a FIFO as a device we just write a VHDL for
it and the development tools (Xilinx -ISE) generates the design and Implements the design in
FPGA which stands for (Field Programmmable Gate Array) as I shown in my design
description.
As I can from this implementation I did not have to do the detail electronic design all I
did is to write a VHDL code to describe FIFO and the lSE tools did the rest.

Ill

INTRODUCTION
The aim of this project is to design simulate and generate the programming code for a
512*36 FIFO to implement into Virtex-Il FPGA device.
The Virtex-Il FPGA series provides dedicated on-chip blocks of 18 Kbit True DualPort synchronous RAM for use in FIFO applications. My project describes a way to create a
common-clock

(synchronous) version of a 511 * 36 FIFO, with the depth and width being

adjustable within the VHDL code.
The project consists of introduction, two chapters and conclusion.
Chapter one presents how to make a project by using ISE and the software properties
which are used in the project.
Chapter two describes the development of FIFO and how it works.
Finally, the conclusion

section presents the important results obtained within the

project.
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1. VHDL GENERAL INFORMATION

1. 1

What is VHDL
The "V" stands for VHSIC (Very High Speed Integrated Circuit), and the "HDL"

stands for "Hardware Description Language'.

1.2

Application Areas

1.2.1 Electronic Design Process
Let us now look at the stages involved in designing an electronic system, and see
which are the main application areas of VHDL.
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Figure 1- 1 Electronic Design Process

This

Diagram

shows

the complete

electronic

design

Process,

from

the

requirements for the system, through hardware and software partitioning, down to the
specification and implementation of the hardware and software parts of the completed
system.

1.2.2. Hardware Implementation
In the early 1990s, VHDL was being used primarily for complex ASIC design,
using synthesis tools to automatically create and optimize the implementation. Then the
use of VHDL with synthesis has moved into the area of programmable logic design.

Modeling Specifications:
There is also an increase in the use of VHDL for modeling specifications, both of
hardware part of the system, and the complete system itself.

1.3

Limitation of VHDL
VHDL is primarily a digital design language. It currently has very limited

capabilities in the analog area, and there is a lot of work going on to standardize an
analog version of the language. The 1076 standard defines a language and its syntax,
without describing any styles of using it on a design project.
That VHDL code may need to be slightly modified before it can be used with
different synthesis tool set than it was originally written for.

1.4

Levels of Abstraction
The different styles of writing VHDL code are to do with a concept known as

abstraction. Abstraction defines how much detail about the design is specified in a
particular description of it.

Let's look at the 4 main levels of abstraction to illustrate the principle.
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Behavioral

RTL

Logic

Layout

Figure 1- 2 Levels of Abstraction

Layout Level:
The lowest level of abstraction is the layout level. This specifies information
about the actual layout of the design on silicon, and may also specify detail timing
information and analog effects.

Logic Level:
Above the layout level is the logic level, where we interconnect logic gates and
registers. Layout information is ignored, and the design contains information about the
function, architecture, technology and detailed timing.
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Figure 1- 3 Register Transfer Level
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Register Transfer Level:
At the Register Transfer Level we Use VHDL in a strict style that defines every
register in the design, and the logic between them. The design still contains architecture
information but not the details of the details of the technology. Absolute timing delays
are not specified.

Behavioral:
Above the RTL, we have the behavioral level. This level uses VHDL to describe
the function of a design, without specifying the architecture of registers. Behavioral
code can contain as much timing information as the designer requires representing his
function.

Function
only

Figure 1- 4 Behavioral

1.5

Behavioral Versus RTL
So we see that there are at least two distinct styles of using VHDL: Behavioral,

and RTL.
At RTL style the designer has control over the architecture of the registers in his
design.
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Figure 1- 5 Logic Synthesis

At Behavioral style the synthesis tools generates the architecture.

Behavioral

Behavioral
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Layout

Figure I- 6 Behavioral Synthesis
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1.6. Overview of Synthesis for Xilinx Devices
1.6.1. What will be covered

PLD technologies:

PLD

VERSUS
ASIC

Figure 1-7 PLD versus ASIC

First PLD architectures will be discussed. How they differ from ASICs and how
this effects design methodologies.

Then we will architectures of two types of Xilinx

PLD. These are FPGAs and CPLDs.

Xilinx PLDs:
Then will look at the architectures of the two types of Xilinx PLD. These are
FPGAs and CPLDs.
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Architectures:

Xilinx

VHDL Design Entry

Jl.
Synthesis

Jt
Implementation in a Xilinx Device

Figure 1-8 Xilinx Architecture

Then we will look at how these characteristics impact on the style in which you
write your code.

1.6.2. Terminology
Here are the definitions Xilinx uses:

PLDs:

PLD

CPLD

Figure 1- 9 The PLDs
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The term PLD (Programmable

Logic Device) covers all of the programmable

devices that Xilinx offers. The two types of PLD that Xilinx offer are the FPGA ("Field
Programmable Gate Array"), and the CPLD or "Complex PLD".

FPGAs, CLDs:
The Xilinx FPGA technologies are SRAM-based,

such as the XC4000e. The

Xilinx CPLD architecture are EPROM or FLASH technology based, en example of
which is the XC9000 series.

Implementation:
The term "implementation

is used to describe the process of turning the logic

design into a physical design i.e. placing and routing the design and downloading into
the target device.

1.6.3.

PLD Synthesis Issues
Lets begin by looking into what we need to consider when using synthesis for the

design of PLDs.
First synthesis users designed ASJCs (Application Specific Integrated Circuits),
where you can only program the device once.
Then it moved into PLD-based technologies. Where, you can re- program the
device many times.
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Synthesizing to PLD technologies:

VHDLCODE

Synthesis

PLD

Figure 1- 10 Synthesis to PLD

From a synthesis perspective, the tool needs to contain specific algorithms to
map the logic into the most efficient combination of the large building blocks.

1.6.4.

Xilinx Device Architectures
We will give you an overview of the Xilinx device architectures.

1.6.5

FPGA Technologies
Xilinx FPGA technologies are based on static RAM building blocks which need

to be downloaded with their logical function each time the system is powered up.

Configurable Logic Blocks (CLB):
Each building block in a given Xilinx FPGA device is known as Configurable
Logic Block (CLB)
A CLB is a cell consisting of 8 or more inputs, 3 or more outputs, some
combinational logic and two or more registers.
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Connection by programmable switches:
The CPLDs are arranged into a fixed matrix and are connected by programmable
switches. These form the required signal nets between CLBs.

CLB

CLB

~

-----CLB

CLB

Figure 1- 11 Connection

IOBs provide IO (Input/Output) connections:
The matrix of logic cells is surrounded by IO cells called IOBs (Input Output
Blocks). These IO cells have different structure from the CLBs and can be configured to
provide different types of IO interface
Input/Output
Blocks
~

~I~

JOB
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r:
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~

--------
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-----------

Figure 1- 12 VO
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----------JOB

1.6.6.

CPLD Technologies
CPLD technologies are not based on static RAM building blocks and they don't

need to be downloaded with their logical function each time the system is powered up.
They have bigger physical size, and accommodate less function. CPLD technologies is
mainly useful for smaller applications. CPLDs are based on a different type of building
block than used in FPGAs. In a CPLD, each building block is referred to as a Function
Block (FB). Each FB is comprised of macro cells, each capable of implementing

a

combinational or registered function.
These function blocks are connected via a switch matrix.

1.6.7.

Where PLD Specific Issues Occur
So, having looked at the architecture of PLD technologies, we can now move on

to look at the main areas of interest from the coding style and synthesis point of view.

Efficient mapping to PLD architecture
The synthesis tool must be able to map the VHDL Code into an efficient
utilization of CLBs.
However, the style in which you write your code can help the synthesis tool to
obtain better results.

Good Coding Style
Good coding style means that the synthesis tool can identify constructs within
your code that it can easily map to technology features.

1.6.8. How the PLD Specific Issues are Handled
The key to using PLD resources efficiency is to write your VHDL so that it
makes the best use of the architectures available within the target device.

Architecture independence
An important advantage of designing with VHDL is that the description can be
independent of architecture, an can be re targeted to a new architecture if required.
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However the code that is purely generic may not make the most efficient use of
architecture specific features.

Architecture independence versus efficiency
A trade off exists here. You might want to keep the code architecture
independent, leaving the synthesis tool to infer the best resources for the target device,
or you might use architecture specific constructs to exploit pre-optimized functions at
he expense of architecture independence.

Inference can be difficult
In fact not all functions can be inferred by a synthesis tool. For instance, some
tools do not infer RAM. Hence users are sometimes required to make specific reference
to these parts in their code. This is known as instantiation.
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2. FIFO USING VIRTEX-11 BLOCK RAM DESIGN WITH
ISE

2. 1. Design Description

My design is synchronous 512*36 (512 adresses and each address has 36 bit or
data) FIFO.
FIFO is an acronym for First In, First Out. An abstraction

is a ways of

organizing and manipulation of data relative to time and prioritization.
In software FIFO is used in queue process.
In hardware FIFO is used commonly in electronic circuits for buffering and flow
control.

2.1.1. Synchronous FIFO Using Common Clocks
Figure 1.1 is a block diagram of a synchronous FIFO. When both the Read and
Write clocks originate from the same source, it simplifies the operation and arbitration
of the FIFO, and the Empty and Full flags can be generated more easily. Binary
counters are used for both the read (read_addr) and write (write_addr) address counters.
Table 1-1 lists the Port Definitions for a synchronous FIFO design.
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Table 1-1 Port Definitions

Signal Name

Port Direction

Port Width

clock_in

input

1

tifo_gsr _in

input

1

wnte.. enable in

input

1

wnte_data_in

input

'.36

reecenable jn

input

1

read_ data out

output

'.36

full_out

output

1

emptyout

output

1

fifocountout

output

4

2.1.2. Synchronous FIFO Operation
To perform a read, Read Enable (read_enable) is driven High prior to a rising
clock edge, and the Read Data (read_data) will be presented on the outputs during the
next clock cycle. To do a Burst Read, simply leave Read Enable High for as many clock
cycles as desired, but if Empty goes active after reading, then the last word has been
read, and the next Read Data would be invalid.
14

To perform a write, the Write Data (write_data) must be present on the inputs,
and Write Enable (write_enable) is driven High prior to a rising clock edge. As long as
the Full flag is not set, the Write will be executed. To do a Burst Write, the Write
Enable is left High, and new Write Data must be available every cycle.
A FIFO count (fifocount) is added for convenience, to determine when the FIFO
is 1/2 full, % full, etc .. It is a binary count of the number of words currently stored in the
FIFO. It is incremented

on Writes, decremented

on Reads, and left alone if both

operations are performed within the same clock cycle. In this application, only the upper
four bits are sent to VO, but that can easily be modified.
The Empty flag is set when either the fifocount is zero, or when the fifocount is
one and only a Read is being performed. This early decoding allows Empty to be set
immediately

after the last Read. It is cleared after a Write operation

(with no

simultaneous Read). Similarly, the Full flag is set when the fifocount is 511, or when
the fifocount is 510 and only a write is being performed. It is cleared after a Read
operation (with no simultaneous Write). If both a Read and Write are done in the same
clock cycle, there is no change to the status flags. During Global Reset (fifo_gsr), both
these signals are driven High, to prevent any external logic from interfacing with the
FIFO during this time.
I used the VHDL (Very High Speed Hardware Description Language) to design
this FIFO.
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2.2. Design Flow
My design flow is shown in Figure 2.

REQUIREMENT

i
SPECIFICATION

i
WRITE THE VHDL CODE

l
DEFINE THE INPUTS

l
DEFINE THE FUNCTION

1~

•

WRITE THE VHDL CODE

If there is an error in tlu
VHDL codes

l
ENTER THE DESIGN

l
SYNTHESIZE
If there is an error corr
the VHDL code

i
WRITING TEST BENCH

i
SIMULATING

Figure 2.1 Design Process
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2.2.1. Requirements

•

FIFO

•

Clock frequency is 160 MHz

2.2.2. Specification

•

512 locations

•

36 bits in each location

•

The output and input will be synchronize with the clock

2.2.3. The Inputs and Outputs of the FIFO

inputs
•

clock in

•

fifo_gsr_in

•

write_enable

•

write_data_in

•

read_enable

m

in

outputs
•

full_out

•

empty_out

•

read_data_out

•

fifo_count_out
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2.2.4. The Functions in VHDL Code
Write processes is in the VHDL code for the functions shown is in the blog
diagram.Write processes for the following functions as shown in the blog diagram.

1. Processes

for the Status Flag Generation Logic (procl, proc2 and proc7 in the

VHDL code)
2. Fifo count (9-bit binary counter) (proc3 and proc4 in my code)
3. Process for read counter (proc5)
4. Process for write counter (proc6)
5. Instantiatiated block RAM (RAMB16_S36_S36)
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2.2.5. Write the VHDL Code
I used to entity section of the VHDL code to implement the inputs and outputs.I use
the architecture section of the VHDL code to implement the processes.

Module

: fifoctlr_cc_ v2. vhd

Last Update: 26/March/2008

Description : FIFO controller top level.
Implements a 511 x36 FIFO w/common read/write clocks.

The following VHDL code implements a 511x36 FIFO in a Virtex2
device. The inputs are a Clock, a Read Enable, a Write Enable,
Write Data, and a FIFO_gsr signal as an initial reset. The outputs
are Read Data, Full, Empty, and the FIFOcount outputs, which
indicate how full the FIFO is.

Designer

University

: Esra Tugba Oguzhanoglu

: YDU

library ieee;
use ieee.std_logic_l 164.all;
use ieee.std_logic_unsigned.all;

-- synopsys translate_off
library UNISIM;
use UNISIM.VCOMPONENTS.ALL;
-- synopsys translate_on

entity fifoctlr_cc_ v2 is
p011 (clock_in:

IN std_logic;
19

read_enable_in:

IN std_logic;

write_enable_in:

IN std_logic;

write_data_in:

IN std_logic_ vector(35

fifo_gsr_in:

IN std_logic;

read_data_out:
full_out:

downto O);

OUT std_logic_ vector(35

downto O);

OUT std_logic;

empty_out:

OUT std_logic;

fifocount_out:

OUT std_logic_ vector(3 downto O));

END fifoctlr_cc_ v2;

architecture

fifoctlr_cc_ v2_hdl of fifoctlr_cc_ v2 is

signal clock:

std_logic;

signal read_enable:

std_logic;

signal write_enable:

std_logic;

signal fifo_gsr:
signal

std_logic;

read_data:

std_logic_ vector(35

downto

''000000000000000000000000000000000000'';
signal write_data:
signal full:
signal empty:

std_Iogic_ vector(35

downto 0);

std_Iogic;
std_Iogic;

signal read_addr:

std_logic_ vector(8 downto 0) := "000000000";

signal write_addr:

std_logic_ vector(8 downto 0) := "000000000";

signal fcounter:

std_logic_ vector(8 downto 0) := "000000000";

signal read_allow:

std_logic;

signal write_allow:

std_logic;

signal fcnt_allow:

std_logic;

signal f cntandout:

std_logic_ vector(3 down to O);

signal ra_or_fcntO:

std_logic;

signal wa_or_fcntO:
signal emptyg:
signal fullg:
signal gnd_bus:

std_logic;
std_logic;
std_logic;
std_logic_ vector(35 down to O);

signal gnd:

std_logic;

signal pwr:

std_logic;
20

0)

-

component

BUFGP

port (
I: IN std_logic;
0: OUT std_logic);
END component;

component

RAMB16_S36_S36

port (
ADD RA: IN std_logic_ vector(8

downto 0);

ADDRB:

downto O);

IN std_logic_ vector(8

DIA:

IN std_logic_ vector(31

downto O);

DIB:

IN std_logic_ vector(3 l downto 0);

DIPA: IN std_logic_ vector(3 downto O);
DIPB: IN std_logic_ vector(3 downto 0);
WEA:

IN std_logic;

WEB:

IN std_logic;

CLKA: IN std_logic;
CLKB: IN std_logic;
SSRA: IN std_Iogic;
SSRB: IN std_logic;
ENA:

IN std_logic;

ENB:

IN std_logic;

DOA:

OUT std_logic_ vector(3 l down to O);

DOB:

OUT std_Iogic_ vector(31 downto O);

DOPA: OUT std_logic_ vector(3 downto O);
DOPB: OUT std_logic_ vector(3 downto O));
END component;

BEGIN
read_enable <= read_enable_in;
write_enable <= write_enable_in;
fifo_gsr <= fifo_gsr_in;
write_data <= write_data_in;
21

read_data_out <= read_data;
full_out <= full;
empty_out <= empty;
gnd_bus <= "000000000000000000000000000000000000";
gnd <= 'O';
pwr <= '1 ';

-- A global buffer is instantianted to avoid skew problems.

gclkl: BUFGP port map (I=> clock_in, 0 => clock);

-- Block RAM instantiation for FIFO. Module is 5 l 2x36, of which one
-- address location is sacrificed for the overall speed of the design. --

braml: RAMB l 6_S36_S36 port map (ADDRA => read_addr, ADDRB => write_addr,
DIA=> gnd_bus(35 downto 4), DIPA => gnd_bus(3 downto 0),
DIB => write_data(35 downto 4), DIPB => write_data(3 downto 0),
WEA => gnd, WEB => pwr, CLKA => clock, CLKB => clock,
SSRA => gnd, SSRB => gnd, ENA=> read_allow, ENB => write_allow,
DOA=> read_data(35 downto 4), DOPA=> read_data(3 downto 0) );

Set allow flags, which control the clock enables for
read, write, and count operations.

22

procl: PROCESS (clock, fifo_gsr)
BEGIN
IF (fifo_gsr = '1 ') THEN
read_allow <= 'O';
ELSIF (clock'EVENT AND clock= '1') THEN
read_allow <= read_enable AND NOT (fcntandout(O) AND fcntandout(l)
AND NOT write_allow);
END IF;
END PROCESS procl;

proc2: PROCESS (clock, fifo_gsr)
BEGIN
IF (fifo_gsr = 'l ') THEN
write_allow <= 'O';
ELSIF (clock'EVENT AND clock= 'l ') THEN
write_allow <= write_enable AND NOT (fcntandout(2) AND fcntandout(3)
AND NOT read_allow);
END IF;
END PROCESS proc2;

fcnt_allow <= write_allow XOR read_allow;

Empty flag is set on fifo_gsr (initial), or when on the --- next clock cycle, Write Enable is low, and either the
-- FIFOcount is equal to 0, or it is equal to 1 and Read
Enable is high (about to go Empty).

ra_or_fcntO <= (read_allow OR NOT fcounter(O));
23

--

fcntandout(O) <= NOT (fcounter(4) OR fcounter(3) OR fcounter(2) OR fcounter(l) OR
fcounter(O));
fcntandout(l) <= NOT (fcounter(8) OR fcounter(7) OR fcounter(6) OR fcounter(5));
emptyg

<=

(fcntandout(O)

AND

fcntandout(l)

AND

ra_or_fcntO

AND

NOT

write_allow);

proc3: PROCESS (clock, fifo_gsr)
BEGIN
IF ( fifo _gsr = 'l ') THEN
empty<= 'l ';
ELSIF (clock'EVENT AND clock= 'l ') THEN
empty<= emptyg;
END IF;
END PROCESS proc3;

Full flag is set on fifo_gsr (but it is cleared on the -first valid clock edge after fifo_gsr is removed), or

--

when on the next clock cycle, Read Enable is low, and

--

either the FIFOcount is equal to I FF (hex), or it is
-- equal to I FE and the Write Enable is high (about to go
-- Full).

wa_or_fcntO <= (write_allow OR fcounter(O));
fcntandout(2) <= (fcounter(4) AND fcounter(3) AND fcounter(2) AND fcounter(l));
fcntandout(3) <= (fcounter(8) AND fcounter(7) AND fcounter(6) AND fcounter(5));
fullg <= (fcntandout(2) AND fcntandout(3) AND wa_or_fcntO AND NOT read_allow);

proc4: PROCESS (clock, fifo_gsr)
BEGIN
IF (fifo_gsr ='I') THEN
24

full<= '1 ';
ELSIF (clock'EVENT AND clock= '1 ') THEN
full <= fullg;
END IF;
END PROCESS proc4;

Generation of Read and Write address pointers. They now
use binary counters, because it is simpler in simulation, -and the previous LFSR implementation wasn't in the
-- critical path.

proc5: PROCESS (clock, fifo_gsr)
BEGIN
IF (fifo_gsr = '1 ') THEN
read_addr <= "000000000";
ELSIF (clock'EVENT AND clock= 'I') THEN
IF (read_allow = '1 ') THEN
read_addr <= read_addr + '1 ';
END IF;
END IF;
END PROCESS proc5;

proc6: PROCESS (clock, fifo_gsr)
BEGIN
IF (fifo_gsr = '1 ') THEN
write_addr <= "000000000";
ELSIF (clock'EVENT AND clock= '1 ') THEN
IF (write_allow = '1 ') THEN
write_addr <= write_addr + '1 ';
END IF;
25

END IF;
END PROCESS proc6;

Generation of FIFOcount outputs. Used to determine how
full FIFO is, based on a counter that keeps track of how -many words are in the FIFO. Also used to generate Full

--

and Empty flags. Only the upper four bits of the counter -are sent outside the module.

proc7: PROCESS (clock, fifo_gsr)
BEGIN
IF (fifo_gsr = '1 ') THEN
fcounter <= "000000000";
ELSIF (clock'EVENT AND clock= '1 ') THEN
IF (fcnt_allow = '1 ') THEN
IF (read_allow = 'O') THEN
fcounter <= fcounter + '1 ';
ELSE
fcounter <= fcounter - '1 ';
END IF;
END IF;
END IF;
END PROCESS proc7;

fifocount_out <= fcounter(8 downto 5);

END fifoctlr_cc_v2_hdl;

I use the xilinx - ISE integrated software and enviroment to create the FIFO
Project an enter the VHDL code.
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2.3. Design Steps
2.3.1. Create the FIFO Project
Create the FIFO project which will target the FPGA device on the Virtex-2.

To create the FIFO project:
1. Select File > New Project ... The New Project Wizard appears.
2. Type fifoctrl_cc_ v2 in the Project Name field.
3. Enter to location and a fifo subdirectory is created automatically.
4. Verify that HDL is selected from the Top-Level Source Type list.

Sources

No project is open
Select
File->Or,enProiecr

,

ne·)MewPro,ecr

Precesses

Protecl Nome

Prcect tocetco

l~ocut_c(_ .•. ~

( \XJIH"i><Sl1\arlir,x\J'n.YD1o,ec.t\1!1()((1i_cc._v2

No flow available

Lco-LevelSocsce Type
HDL

X

Con.sole

~

Eum

L Warnings

;BJ Tel She~

·l<i fw.c:1.nF~~

Figure 3.1 Project Name

5. Click Next to move to the device properties page.
6. Fill in the properties in the table as shown below:

•
•
•
•

Product Category: All
Family: Virtex2
Device: XC2V40
Package: CS144
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•

Speed Grade: -6

•

Top-Level Source Type: HDL

•

Synthesis Tool: XST (VHDLNerilog)

•

Simulator: ISE Simulator (VHDLN erilog)

•

Preferred Language: VHDL

•

Verify that Enable Enhanced Design Summary is selected.

Leave the default values in the remaining fields.
When the table is complete, my project properties will look like the following:

·-

No project is open
FilNO:ienPto,e::,

~

Fk·>New-Ptotee'

P1opertyNi1me
Processes

P1oductCotegcwy

No flow available

family
Device

XCNtO

Pacl,.age

($144

Speed

f

Top-Level SOU1ce Type
XS 1 f;'HQLNenlog)
ISE Simo.,i.;,:orfVHDLNei-.iogJ
PrereoeoLongvoge

VHDL

E~ErJ-..,.ncedDes",)(,Surnmai~
Enable Message Fikeung
Orspiaylno-erne.ntalMessage~

Figure 3.2 Project Device Properties

7. Click Next to proceed to the Create New Source window in the New Project Wizard.
At

the end of the next section, my FIFO project will be complete.
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2.3.2. Create the HDL Source of the FIFO
In this section, I will create the top-level HDL file for my design. Determine the
language that I wish to use for the tutorial. Then, continue either to the "Creating a
VHDL Source" section below.

Creatinga new source to add to the ooecr is optional Only one l\eW sooce CMI be c1eatedl".'ilh lhe New Projectl.,,.lizaid
Addit~ touces C¥1 be created iYXI 3dded to the project by usnQ the "Project->New Scoce" command
E ~,sting soc ces con be added

Ofl

the next page

http:/A"VVNl-><i1inx. com

Co-eote

€3Euo,~

4 !cl Shel

00 FndrnFiles

Figure 3.3 New Sources

2.3.3. Creating a VHDL Source
Create a VHDL source file for the project as follows:
1. Click the New Source button in the New Project Wizard.
2. Select VHDL Module as the source type.
3. Type in the file name fifoctrl_cc_ v2.
4. Verify that the Add to project checkbox is selected.
5. Click Next.
6. Declare the ports for the fifo design by filling in the port information as shown
below.
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Sources

No project is open

''"'"
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File·>OpenProiect
Frle->NewProject

No flow available.
:reao::l_enahle_W"l
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·read_data_oul
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empty_oul
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I
t

!

ui ..

----- I

r··MO!elnlo

·i ~

1

Co-see

t')Enm

,LWai-nings

~TclShel

MIFindinFks

Figure 3.4 Define Module

7. Click Next, then Finish in the New Source Wizard - Summary dialog box to
complete
the new source file template.
8. Click Next, then Next, then Finish.
The source file containing the entity/architecture pair displays in the Workspace,
and the fifo displays in the Source tab, as shown below:
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Figure 3.6 Completed VHDL Source
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2.3.4. Syntax Checks

Checking the Syntax of the FIFO
When the source files are complete, check the syntax of the design to find errors
and typos.

1. Verify that Synthesis/Implementation

is selected from the drop-down list in the

Sources window.

'.'.jfiloctrl_cc_v2
- (Jxc2v40-6csl44
S,t..1:)iloctil_cc_v2· fifoclk_cc_v2_hdl!ffoctrl_cc_v2.vhd)

'---'
~

e
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Figure 3.7 Check Syntax

2. Select the fifoctrl_cc_ v2 design source in the Sources window to display the related
processes in the Processes window.
3. Click the"+" next to the Synthesize-XST process to expand the process group.

4. Double-click the Check Syntax process.
5. Syntax check completed successfully.

Note: I must correct any errors found in my source files. I can check for errors in the
Console tab of the Transcript window. If I continue without valid syntax, I will not be
able to simulate or synthesize my design.
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2.3.5. Synthesize

dit View
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Figure 3.8 Synthesize

Synthesize completed successfully.
I use the xilinx 'synthesize

tool' to synthesize the code. The synthesize result is

shown below.

Release 9.1 i - xst J .30
Copyright (c) 1995-2007 Xilinx, Inc. All rights reserved.
--> Parameter TMPDIR set to ./xst/projnav.tmp
CPU : 0.00 I 1.11 s I Elapsed : 0.00 I 1.00 s

--> Parameter xsthdpdir set to ./xst
CPU : 0.00 I 1.16 s I Elapsed : 0.00 I 1.00 s

--> Reading design: fifoctlr_cc_ v2.prj

TABLE OF CONTENTS
1) Synthesis Options Summary
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2) HDL Compilation
3) Design Hierarchy Analysis
4) HDJ._ Analysis
5) HDL Synthesis
5.1) HDL Synthesis Report
6) Advanced HDL Synthesis
6.1) Advanced HDL Synthesis Report
7) Low Level Synthesis
8) Partition Report
9) Final Report
9.1) Device utilization summary
9.2) Partition Resource Summary
9.3) TIMING REPORT

---------------------------------------------------------------------------------------------------------------------------

*

Synthesis Options Summary

*

---- Source Parameters
Input File Name
Input Format

: "fifoctlr_cc_ v2.prj"
: mixed

Ignore Synthesis Constraint File

: NO

---- Target Parameters
Output File Name

: "fifoctlr_cc_ v2"

Output Format

:NGC

Target Device

: xc2v40-6-fg256

---- Source Options
Top Module Name

: fifoctlr_cc_ v2

Automatic FSM Extraction

: YES

FSM Encoding Algorithm

: Auto
34

Safe Implementation
FSM Style

: No
: Jut

RAM Extraction

: Yes

RAM Style

: Auto

ROM Extraction
Mux Style

: Yes
: Auto

Decoder Extraction

: YES

Priority Encoder Extraction

: YES

Shift Register Extraction

: YES

Logical Shifter Extraction

: YES

XOR Collapsing

: YES

ROM Style

: Auto

Mux Extraction

: YES

Resource Sharing

: YES

Asynchronous To Synchronous
Multiplier Style

: NO

: auto

Automatic Register Balancing

: No

---- Target Options
Add IO Buffers

: YES

Global Maximum Fanout

: 500

Add Generic Clock Buffer(BUFG)
Register Duplication
Slice Packing

: 16

: YES
: YES

Optimize Instantiated Primitives
Convert Tristates To Logic
Use Clock Enable
Use Synchronous Set
Use Synchronous Reset

: NO
: Yes

: Yes
: Yes
: Yes

Pack IO Registers into IOBs

: auto

Equivalent register Removal

: YES

---- General Options
Optimization Goal

: Speed
35

: 1

Optimization Effort
Library Search Order

: fifoctlr_cc_ v2.lso

Keep Hierarchy

: NO

RTL Output

: Yes

Global Optimization

: AllClockNets

Read Cores

: YES

Write Timing Constraints

: NO

Cross Clock Analysis

: NO
:I

Hierarchy Separator
Bus Delimiter

: <>

Case Specifier

: maintain

Slice Utilization Ratio

: 100

BRAM Utilization Ratio
Verilog 2001

: 100
: YES

Auto BRAM Packing

: NO

Slice Utilization Ratio Delta

: 5

---------------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------------

HDL Compilation
*
*
--------------------------------------------------------------

vhdl

Compiling

file

Settings/esra/Desktop/ESRA/fifoctrl_cc_

"C:/Documents

v2.vhd" in Library work.

Architecture fifoctlr_cc_ v2_hdl of Entity fifoctlr_cc_ v2 is up to date.

---------------------------------------------------------------------------------------------------------------------------

--------------------*

Design Hierarchy Analysis

*
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and

----------Analyzing

hierarchy

for entity <fifoctlr_cc_ v2> in library· <work>

(architecture

<fifoctlr_cc_ v2_hdl> ).

-----------------------------------------------------------------------HDL Analysis
*
*
--------------------------------------------------------------

Analyzing

Entity

<fifoctlr_cc_ v2>

in

library

<work>

(Architecture

<fifoctlr_cc_ v2_hdl> ).
WARNING:Xst:2211

"C:/Documents

Settings/esra/Desktop/ESRA/fifoctrl_cc_

v2.vhd"

line

111: Instantiating

and
black

box

module <BUFGP>.
WARNING:Xst:753

"C:/Documents

Settings/esra/Desktop/ESRA/fifoctrl_cc_

v2.vhd" line 120: Unconnected

and
output port

'DOB' of component 'RAMB16_S36_S36'.
W ARNING:Xst:753

"C:/Documents

Settings/esra/Desktop/ESRA/fifoctrl_cc_

v2. vhd" line 120: Unconnected

and
output port

'DOPB' of component 'RAMB16_S36_S36'.
WARNING:Xst:2211

-

Settings/esra/Desktop/ESRA/fifoctrl_cc_

"C:/Documents
v2.vhd"

line

120: Instantiating

and
black

box

module <RAMB l6_S36_S36>.
Entity <fifoctlr_cc_ v2> analyzed. Unit <fifoctlr_cc_ v2> generated.

-----------------------------------------------------------------------------------------------------------------------------------------------

*

*

HDL Synthesis

--------------------37

Performing bidirectional port resolution ...

Synthesizing Unit <fifoctlr_cc_ v2>.
Related

source

file

Settings/ esra/Desktop/ESRA/fifoctrl_

lS

"C:/Documents

cc_ v2. vhd".

Found I-bit register for signal <empty>.
Found I-bit xor2 for signal <fcnt jillow>.
Found 9-bit updown counter for signal -cfcounter».
Found I-bit register for signal <full>.
Found 9-bit up counter for signal <read_addr>.
Found I-bit register for signal <read_allow>.
Found 9-bit up counter for signal <write jiddr>.
Found I-bit register for signal <write_allow>.
Summary:
inferred

3 Counter(s).

inferred

4 D-type flip-flop(s).

Unit <fifoctlr_cc_ v2> synthesized.

---------------------------------------------------------------------------------HDL Synthesis Report

Macro Statistics
# Counters

:3

9-bit up counter

:2

9-bit updown counter
# Registers
I-bit register
# Xors
I -bit xor2

: ]

:4
:4
: 1
: 1

---------------------------------------------------------------------------------38

and

-----------------------------------------------------------------------Advanced HDL Synthesis
*
*
------------------------------------------------------------------------

Loading

device

for application

Rf_Device

from file '2v40.nph'

in environment

C:\Xilinx91i.

--------------------Advanced HDL Synthesis Report

Macro Statistics
# Counters

:3

9-bit up counter

:2

9-bit updown counter

: I

# Registers

:4

Flip-Flops

:4

# Xors

: I

I-bit xor2

: ]

-------------------------------------------------------------=
--------------------==----------------------------------------------------------==
---------------------

*

Low Level Synthesis

*
---------------------------------------------------------------------------------Optimizing unit <fifoctlr_cc_ v2> ...

39

Mapping all equations ...
Building and optimizing final netlist ...
Found area constraint ratio of 100 ( + 5) on block fifoctlr cc , v2, actual ratio is 8.

Final Macro Processing ...

--------------------------------------------------------------------------------------------------------------------------Final Register Report

Macro Statistics
# Registers

: 31

Flip-Flops

: 31

--------------------------------------------------------------

Partition Report

*

*

-----------------------------------------------------------------------------------------------------------------------------------------------

Partition Implementation Status

No Partitions were found in this design.

--------------------------------------------------------------------------------------------------------------------------*

Final Report

*
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Final Results
RTL Top Level Output File Name
Top Level Output File Name

: fifoctlr_cc_ v2.ngr
: fifoctlr_cc_v2

Output Format

:NGC

Optimization Goal

: Speed

Keep Hierarchy

:NO

Design Statistics
#IOs

: 82

Cell Usage:
#BELS

: 89

#

GND

: 1

#

INV

#

LUTl

: 16

#

LUT2

: JO

#

LUT2_L

#

LUT4

#

LUT4_D

: 1

#

LUT4_L

: 1

#

MUXCY

#

vcc

#

XORCY

:2

:2

:6

: 24
: 1
: 25

# FlipF!ops/Latches
#

FDC

#

FDCE

#

FDP

#RAMS
#

:2
: 27
:2
: 1

RAMB l 6_S36_S36

# Clock Buffers
#

: 31

BUFGP

# IO Buffers

: 1
: 1
: 1

: 81
41

#

IBUF

#

OBUF

:39
: 42

----------------------------------------------------------------------------------------------------------------------------------------------Device utilization summary:

Selected Device : 2v40f g256-6

Number of Slices:

21 out of

256

8%

Number of Slice Flip Flops:

31 out of

512

6%

Number of 4 input LUTs:

38 out of

512

7%

Number of bonded IOBs:

82 out of

88

93%

Number of BRAMs:

1 out of

4

25%

Number of GCLKs:

1 out of

16

6%

Number of I Os:

82

Partition Resource Summary:

No Partitions were found in this design.

-------------------------------------------------------------TIMING REPORT

NOTE: THESE TIMING NUMBERS ARE ONLY A SYNTHESIS ESTIMATE.
FOR ACCURATE TIMING INFORMATION
REPORT
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PLEASE REFER TO THE TRACE

GENERA TED AFTER PLACE-and-ROUTE.

Clock Information:

------------------------------------t--------------------------t---------tClock Signal

I Clock buffer(FF name) I Load

------------------------------------t--------------------------t---------tclock_in

IBUFGP

J32

------------------------------------t--------------------------t---------t-

Asynchronous Control Signals Information:

------------------------------------t--------------------------t---------tControl Signal

I Buffer(FF name)

I Load I

------------------------------------t--------------------------t---------tfifo_gsr_in

I IBUF

J31

------------------------------------t--------------------------t---------t-

Timing Summary:

Speed Grade: -6

Minimum period: 3.389ns (Maximum Frequency: 295.072MHz)
Minimum input arrival time before clock: l .900ns
Maximum output required time after clock: 4.745ns
Maximum combinational path delay: No path found

Timing Detail:

All values displayed in nanoseconds (ns)

Timing constraint: Default period analysis for Clock 'clock_in'
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Clock period: 3.389ns (frequency:

295.072MHz)

Total number of paths I destination ports: 321 I 78

Delay:
Source:
Destination:

3.389ns (Levels of Logic= 10)
read_allow (FF)
fcounter_8 (FF)

Source Clock:

clock_in rising

Destination Clock: clock_in rising

Data Path: read_allow to fcounter_8
Gate
Cell.in-c-out

Net

fanout

FDC:C->Q

Delay

Delay Logical Name (Net Name)

23 0.449

0.947 read_allow (read_allow)

0.347

0.000 Mcount_fcounter_lut<O>

LUT2:Il->0
MUXCY:S->0

(N6)

0.235

0.000

Mccunt fcounter cy-cu»

0.042

0.000

Mcount_fcounter_cy<l

0.042

0.000

M count_fcounter _cy<2>

0.042

0.000

Mcount_fcounter_cy<3>

0.042

0.000

Mcount_fcounter_cy<4>

0.042

0.000

Mcount_fcounter_cy<5>

0.042

0.000

Mcount_fcounter_cy<6>

0.042

0.000

Mcount_fcounter_cy<7>

(Mcount_fcounter_cy<O>)
MUXCY :CI->0
(Mcount_fcounter_cy<l

>)

MUXCY:CI->0
(Mcount_fcounter_cy<2>)
MUXCY:CI->0
(Mcount_fcounter_cy<3>)
MUXCY:CI->0
(Mcount_fcounter_cy<4>)
MUXCY:CI->0
(Mcount_fcounter_cy<5>)
MUXCY :CI->0
(Mcount_fcounter_cy<6>)
MUXCY:CI->0

0

(Mcount_fcounter_cy<7>)
XORCY:CI->0
FDCE:D

>

0.824
0.293

0.000 Mcount_fcounter_xor<8>
fcounter_8
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(Result-cs»)

Total

3.389ns (2.442ns logic, 0.947ns route)
(72.1 % logic, 27.9% route)

Timing constraint: Default OFFSET IN BEFORE for Clock 'clock_in'
Total number of paths I destination ports: 38 I 38

Offset:
Source:
Destination:

l .900ns (Levels of Logic = 2)
write_enable_in (PAD)
write_allow (FF)

Destination Clock: clock_in rising

Data Path: write_enable_in to write_allow
Gate
Cell.in-e-out

fanout

Net
Delay

0.653

IBUF:1->0
LUT4:I0->0

1

FDC:D

0.293

Total

Delay Logical Name (Net Name)

0.607 write_enable_in_IBUF

0.347

(write_enable_in_IBUF)

0.000 write_allow_andOOOOl (write_allow_andOOOO)
write_allow

l.900ns (l .293ns logic, 0.607ns route)
(68.0% logic, 32.0% route)

-------------------------------------------------------------Timing constraint: Default OFFSET OUT AFTER for Clock 'clock_in'
Total number of paths I destination ports: 42 I 42

Offset:
Source:
Destination:
Source Clock:

4.745ns (Levels of Logic= 1)
fcounter_8 (FF)
fifocount_out<3> (PAD)
clock_in rising

Data Path: fcounter_8 to fifocount_out<3>
Gate
Cell:in->out

fanout

Net
Delay

FDCE:C->Q

4 0.449

OBUF:I->0

3.743

Total

Delay Logical Name (Net Name)

0.552 fcounter_8 (fcounter_8)
fifocount_out_3_0BUF

4. 7 45ns ( 4.192ns logic, 0.552ns route)
(88.4% logic, 11.6% route)

----------CPU : 9.99 I 11.47 s I Elapsed : 10.00 I 11.00 s

-->

Total memory usage is 136208 kilobytes

Number of errors

:

Number of warnings :
Number of infos

0 ( 0 filtered)
4 ( 0 filtered)
O ( 0 filtered)

(fifocount_out<3>)

Xilinx sythesize tool created the following design. Top level block diagram .

••..•.•.•..••.•• write_data_in (35:.0)
-~clock
-~

in

i--read_data_ou t( 35:0) i--fifocount_out(3:0)

fifo_gsr_in
read enable m

-

----j

----1

-

write enable in

Table 3.9 Top Level Block Diagram

Detailed block diagram.

Table 3.10 Detailed Block Diagram

fu 11 out

1----

2.3.6. Design Simulation

Create a test bench waveform containing input stimulus you can use to verify the
functionality of the fifo. The test bench waveform is a graphical view of a test bench.

Create the test bench waveform as follows:
1. Select the fifoctrl_cc_ v2 HDL file in the Sources window.
2. Create a new test bench source by selecting Project - New Source.
3. In the New Source Wizard, select Test Bench WaveForm

as the source type, and

type
Fifoctrl_cc_ v2_tb in the File Name field.
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Figure 3.11 Create Test Bench

4. Click Next.
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Figure 3.12 Created Test bench

Writing Test Bench
In the test bench generated 160 MHz. I wrote in the data in to the FIFO and read it
back to verify data can be written and read correctly. The simulation result is shown
below.

Company:
Engineer:

Create Date:
Design Name:
Module Name:

14:48:16 03/27/2008
fifoctlr_cc_ v2
C:/Xilinx91 i/xilinx/ESRA/fifoctrl

cc v2/fifoctrl cc v2 tb.vhd

Project Name: fifoctrl cc v2
Target Device:
Tool versions:
Description:

VHDL Test Bench Created by ISE for module: fifoctlr_cc_ v2
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-- Dependencies:

-- Revision:
-- Revision 0.01 - File Created
-- Additional Comments:

-- Notes:
-- This testbench has been automatically generated using types std_logic and
-- std_logic_ vector for the ports of the unit under test. Xilinx recommends
-- that these types always be used for the top-level VO of a design in order
-- to guarantee that the testbench will bind correctly to the post-implementation
-- simulation model.

LIBRARY ieee;
USE ieee.std_logic_l 164.ALL;
USE ieee.std_logic_unsigned.all;
USE ieee.numeric_std.ALL;

ENTITY fifoctrl cc v2 tb vhd IS
END fifoctrl_cc_ v2_tb_ vhd;

ARCHITECTURE

behavior OF fifoctrl_cc_ v2_tb_ vhd IS

-- Component Declaration for the Unit Under Test (UUT)
COMPONENT fifoctlr_cc_ v2
PORT(
clock_in : IN std_logic;
read_enable_in : IN std_logic;
write_enable_in : IN std_Iogic;
write_data_in : IN std_logic_ vector(35 down to 0);
fifo_gsr_in : IN std_logic;
read_data_out : OUT std_Iogic_ vector(35 down to O);
full_out : OUT std_logic;
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empty_out:

OUT std_Iogic;

fifocount_out

: OUT std_logic_ vector(3 downto 0)

);

END COMPONENT;

--Inputs
SIGNAL clock_in : std_Iogic := 'O';
SIGNAL read_enable_in : std_logic := 'O';
SIGNAL write_enable_in : std_Iogic := 'O';
SIGNAL fifo_gsr_in : std_logic := 'O';
SIGNAL write_data_in : std_logic_ vector(35 down to 0) := ( others=>'O');

--Outputs
SIGNAL read_data_out : std_Iogic_ vector(35 down to 0);
SIGNAL full_out: std_Iogic;
SIGNAL emptyout : std_Iogic;
SIGNAL fifocount_out : std_logic_ vector(3 downto 0);

BEGIN

-- Instantiate the Unit Under Test (UUT)
uut: fifoctlr_cc_ v2 PORT MAP(
clock_in => clock_in,
read_enable_in => read_enable_in,
write_enable_in => write_enable_in,
write_data_in => write_data_in,
fifo_gsr_in => fifo_gsr_in,
read_data_out => read_data_out,
full_out => full_out,
empty_out => emptyout,
fifocount_out => fifocount out
);

clock_in <= not clock_in after 6 ns;
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tb: PROCESS
BEGIN

-- Wait 100 ns for global reset to finish
wait for 100 ns;
write_enable_in

<= transport '1 ';

write_ data_in

transport

<=

std_l ogic_ vector' ( "000000000000000000000000000000000000

"); --0

fifo_gsr_in <= transport 'O';

WAIT FOR 12 ns; -- Time=240 ns
write

data_in

transport

<=

std_logic_ vector'( "00000000000000000000000000000000000

I"); --1

WAIT FOR 12 ns; -- Time=280 ns
write

data in

transport

<=

std_logic_ vector'( "0000000000000000000000000000000000

IO"); --2

WAIT FOR 12 ns; -- Time=320 ns
write_data_in

transport

<=

std_logic_ vector'("OOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOl

l "); --3

WAIT FOR 12 ns; -- Time=360 ns
write

data in

transport

<=

std_logic_ vector'( "000000000000000000000000000000000

I00"); --4

WAIT FOR 12 ns;

WAIT FOR 12 ns; -- Time=960 ns
read_enable_in <= transport 'I ';
write_enable_in <= transport 'O';
write_data_in

<=

std_logic_vector'("OOOOOOOOOOOOOOOOOOOOOOOOOOOOOOO
10011 "); --13
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transport

wait; -- will wait forever
END PROCESS;

END;

5. The Associated Source page shows that you are associating the test bench waveform
with the source file fifoctrl_cc_ v2. Click Next.
6. The Summary page shows that the source will be added to the project, and it displays
the source directory, type and name. Click Finish.
Generate the clock and give inputs.
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Figure 3.13 Generate The Clock

7. In the Sources window, select the Behavioral Simulation view to see that the test
bench waveform file is automatically added to your project.
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Figure 3.14 Behavior Simulation Selection

8. Close the test bench waveform.

2.3.7. Simulating Design Functionality
Verify that the fifo design functions as you expect by performing behavior simulation
as follows:
1. Verify that Behavioral Simulation and fifoctrl_cc_ v2_tb are selected in the Sources
window.
2. In the Processes tab, click the "+" to expand the Xilinx ISE Simulator process and
double-click the Simulate Behavioral Model process.
The ISE Simulator opens and runs the simulation to the end of the test bench.
3. To view my simulation results, select the Simulation tab and zoom in on the
transitions.
The simulation waveform results will look like the following:
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Figure 3.15 Simulation Results

4. Verify that the fifo is counting up and down as expected.
5. Close the simulation view. If you are prompted with the following message, "You
have
an active simulation open. Are you sure you want to close it?", click Yes to continue.
I have now completed simulation of my design using the ISE Simulator.
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2.3.8. Programming File Generation Report
Using the ISE tool the generate the programming file.
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ceeervec
.
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packe.9e !9256,
apeed

Loadini;i device
for
C:\Xilinx91i.
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application

Opened
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04
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Figure 3.16 Generation Report

56

mp3"

lny-,·Co!:o
«K

15:06

2.3.9. Programming the Device
Programming the Virtex-Il FPGA.

J~t~e-~;·s~~~···
}-:.:;is~veSeri&I
~~SelectMAP
r~oe~top(orliguation
f-t_~Difect SPI Compal.ion
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Figure 3.16 Programming Device

To program the device we just click the program.
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CONCLUSION
In this project, the 512*36 FIFO is designed using VHDL language and the
Xilinx

ISE tools to program

specification

the Virtex-II

FPGA.

First,

the requirements

and

is written define, the FIFO inputs and outputs are defined, the FIFO

function is defined the VHDL code. Then the Xilinx ISE tools are used to complete the
project.

The benefit that we gained by using a VHDL Xilinx is just to get rid of the
hardware and bundle of cables and resistors, connections after all if only a single cable
or a connection is missing or misplace the whole design can be easily destroyed and
moreover its expensive and could be dangerous.

To sum up the programming in Xilinx has become so convinent that required
results can be easily achieved with precise results.
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